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Acerca de esta Guía del Usuario 

 
Gracias por elegir nuestro Software de Post-Proceso – Compass Solution. Esta guía 

del usuario ofrece una introducción a la instalación del software, gestión de 

proyectos, procesamiento de datos y generación de reportes. La misma lo ayudará a 

familiarizarse con la interfaz y comenzar con su proyecto de manera efectiva. 

 

Aviso Legal 

 
Por favor, lea detenidamente el aviso legal de este software antes de instalar Compass 

Solution. 

1) Compass Solution es un software de post-proceso inteligente, propiedad de 

ComNav Technology Ltd. 

2) ComNav declara que este software ha sido testeado de manera intensiva, pero no 

puede asegurar que sea compatible con todos los sistemas de software o 

hardware, o que esté libre de errores. ComNav no se hace responsable por 

cualquier daño causado por posibles fallas en el rendimiento del software. 

AL INSTALAR EL SOFTWARE Compass Solution, USTED ACEPTA TODOS LOS 

TÉRMINOS ARRIBA LISTADOS. EN EL CASO DE NO ACEPTAR LOS TÉRMINOS, 

POR FAVOR, DESINSTALE EL PROGRAMA INMEDIATAMENTE. 

 

Asistencia Técnica 

 
En el caso de tener dudas o preguntas, y no encontrar la respuesta en este manual, 

por favor, no dude en contactar el punto de venta local donde adquirió el M300Pro. 

También puede solicitar asistencia técnica mediante el sitio web de ComNav 

Technology: www.comnavtech.com o a través del email de Soporte Técnico: 

support@comnavtech.com 

 

 

Sus comentarios 

 
Sus comentarios sobre el software Compass Solution y esta Guía del Usuario, así 

como de otros productos ComNav nos ayudarán a mejorarlos mediante futuras 

revisiones. Por favor, envíe sus comentarios a: support@comnavtech.com. 

http://www.comnavtech.com/
mailto:support@comnavtech.com
mailto:support@comnavtech.com
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1 Introducción 

 
El software Compass Solution es un programa de post-proceso diseñado para 

procesar y analizar datos GNSS (Global Navigation Satellite System) “crudos” (sin 

procesar), para obtener una solución de posición de alta precisión. Puede procesar 

datos de casi todas las constelaciones de satélites GNSS (GPS, GLONASS, Galileo y 

BeiDou/Compass). Sus funciones principales son: 

1) Procesamiento de datos de observación GNSS en formato RINEX y ComNav. 

2) Post-proceso diferencial en modo estático y cinemático. 

3) Ajuste de redes formadas por vectores de líneas base procesados. 

4) Generación de reportes de análisis en varios formatos (HTML, DXF, TXT y KML). 

 
1.1 Instalación 

 

Hacer doble click en el archivo setup.exe de Compass. Elegir el directorio de 

instalación del programa. Por favor, asegúrese de que el programa principal, la llave 

(dongle) y C++2012 están completamente instalados. 

 
Su PC debe poseer como mínimo las siguientes características (o superiores): 

Windows 2000 

CPU: core 2.0GHz; 

Memoria interna > 1G, HD>80 G; 

Resolución de la pantalla: 1280*1024. 

 
1.2 Interfaz del Usuario 

 
Esta sección describe la Interfaz del Usuario y los menús principales de Compass 

Solution. 

⚫ Barra de Menú: contiene todos los menús disponibles. 

⚫ Bara de Herramientas estándar (Standard Toolbar): acceso directo a las 

funciones más utilizadas, incluyendo: Importar archivos de observación, Procesar 

línea base, Ajuste de red. 

⚫ Área de visualización: ventana de visualización principal. 

⚫ Panel de Navegación (Navigation Pane): permite navegar entre diferentes 

visualizaciones de sus datos GNSS, tanto procesados como crudos. 

⚫ Ventana flotante (Float window): muestra la información de datos GNSS crudos o 
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procesados. Barra de Menú -> View -> property to active float window. 

⚫    Ventana de mensajes (Message box): contiene el mensaje de salida, líneas de 
tiempo, y la calidad de las observaciones. 

 

 
 

1.2.1 Barra de Menú 
 

La barra de menú incluye: Archivo (File), Editar (Edit), GNSS, Procesador (Processor), 

Ajuste (Adjustment), Reporte (Report), Herramientas (Tools), Vista (View), Ventana 

(Window) y Ayuda (Help). A continuación se describen las funciones de cada menú: 

 

⚫ Project (Proyecto), Create (Crear), Open (Abrir), Save and close the project 
(Guardar y cerrar el proyecto), Import raw data (Importar datos crudos). 

⚫ GNSS: GPS, Compass(BeiDou) y GLONASS. 

⚫ Param: datum, antena, etc. Unit Configuration (Configuración de unidades) y 
processing configuration (Configuración del procesamiento). 

⚫ Processor (Procesador): Process all or selected baselines (procesar todas las 
líneas base, o solo las líneas base seleccionadas), Baseline settings (ajustes de 
líneas base). 

⚫ Adjustment (Ajuste): Check observation files (Verificar archivos de observación), 

Check Network (Verificar Red), Search Errors (Buscar errores), Adjustment setup 

(Configuración de ajuste) and Run adjustment (Ejecutar ajuste). 

⚫ Application: Output analysis report (Generar reporte de análisis) en varios formatos, 
incluyendo DXF, TXT, KML. 

⚫ Hold-all: the 7-parameters (los 7 parámetros), Coordinate convert (Convertir 
coordenadas), File cutting (Cortar archivo) y Source path (Directorio fuente). 

⚫ Edit (Editar): Undo (Deshacer), Delete the selected items (Eliminar elementos 
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seleccionados), Replace path (Cambiar directorio) y Property of observation sites 
(Propiedades de los sitios de observación). 

⚫ Window (Ventana): Switch map (Cambiar mapa), Observation (Observación) y 
Report (Reporte). 

⚫ Toolbar (Barra de herramientas): Customize and Edit toolbar (Personalizar y Editar 
barra de herramientas). 

⚫ Help (Ayuda): Help (Ayuda) y About Compass Solution (Acerca de Compass 
Solution). 

 
1.2.2 Panel de Navegación 

 

Contiene 5 pestañas: Compass list (Lista Compass), Observation (Observación), 

Dynamic baseline (Línea base dinámica), Static baseline (Línea base estática) y Station 

(Estación). 

⚫ Compass list: Luego del procesamiento dinámico de la línea base, se muestra la 

línea base en el mapa (baseline estática), y la trayectoria de PPK. 

⚫ Observation: muestra la información detallada de los archivos de observación. 

⚫ Dynamic baseline: Lista de líneas base dinámicas 

⚫ Static baseline: Lista de líneas base estáticas 

⚫ Station: Lista de los marcadores de estaciones 

 
Para cambiar la visualización en el área de vista principal, primero debe hacer click en 

○1 Panel de Navegación, luego seleccionar los elementos de visualización particulares 

en el área ○2 . Los elementos seleccionados se mostrarán en el área de visualización. 
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1.3 Flujo de trabajo 

 
El diagrama muestra el 

flujo de trabajo del 

programa Compass 

Solution, el cual 

proporciona una visión 

clara del procesamiento 

de líneas base. 
 

 
2 Gestión de Proyectos 

 
En este capítulo usted aprenderá a crear un proyecto nuevo, importar archivos de datos 

crudos y agregar restricciones de coordenadas. 

 
2.1 Crear un proyecto nuevo 

En primer lugar, debe instalar correctamente el software Compass Solution, y 

descargar los datos GNSS crudos (sin procesar), del receptor a la PC. Luego, ejecute 

Compass Solution -> click en File -> New Project: 

1) Elija el directorio de la carpeta (path) 

2) Ingrese un nombre para el archivo (file) 

3) Seleccione el Sistema de coordenadas (Coordinate System). Puede elegir uno de 

la lista de Sistemas de coordenadas (WGS72, WGS84, Xian80, Beijing54 and 

CGCS2000), o hacer click en Coordinate detail para agregar un sistema/datum local. 
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Recomendaciones: 1) Recomendamos guardar el proyecto y los datos GNSS 

crudos en el mismo directorio, ya que esto facilitará la gestión del proyecto; 2) 

Para descargar los datos GNSS crudos a la PC, utilice la guía Compass receiver 

utility User Guide. 

Haga click en Add (Agregar) para definir un datum nuevo; es posible definir los 

parámetros deseados (elipsoide y proyección) para el nuevo sistema de 

coordenadas. Haga click en Modify (Modificar) para editar los parámetros de 

coordenadas actuales. 
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Primero, tilde la opción “Use default ellipsoid” (Usar elipsoide por defecto), seleccione 

el elipsoide apropiado de la lista, y luego ingrese el nombre del Sistema de 

Coordenadas (Coordinate System Name) 

 
Introduzca 3 o 7 parámetros, en caso de que sea necesario. 

 

Seleccione el modelo de proyección apropiado, e ingrese los parámetros de acuerdo 

con la ubicación del relevamiento. 

 

En Geoid Models (Modelos Geoidales), tilde Add Geoid Modules (Agregar Módulos 

Geoidales), haga click en Add Geoid File (Agregar Archivo de Geoide) para ingresar 

un módulo geoidal. Luego haga click en OK para finalizar la modificación del datum.  
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A continuación, podrá seleccionar el sistema de coordenadas que ha creado, y 

haciendo click en OK activará dicho datum en el proyecto actual. 

 

Aviso: el sistema de coordenadas y sus parámetros también pueden ser editados a través 

de Tools -> Datum manager. 

 

2.2 Importación de archivos de observación crudos 
 

Para importar datos GNSS crudos (sin procesar), haga click en File -> Import en la 

barra de menú. Los archivos de observación estáticos pueden ser importados 

directamente; para datos PPK y dinámicos, debe tildar “Import Dynamic Files” 

(Importar Archivos Dinámicos). 
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Aviso: Compass Solution solo admite datos dinámicos crudos en formato ComNav. 
 

Después de importar los datos crudos, seleccione Observation -> select the 

observation file en el Panel de Navegación, y haga click derecho sobre el nombre 

del archivo para editar sus propiedades, incluyendo Station Name (Nombre de la 

estación) y Antenna Information (Información de la antena). 

 
2.3 Puntos conocidos de anclaje 

 
Para garantizar que todas las estaciones se encuentran dentro de la cuadrícula de su 

sistema de coordenadas local, al menos una estación debe estar fija en un punto 

conocido. Haga click en Station -> Properties -> Known Point para ingresar 

valores de coordenadas (Tilde Constraint). 
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Aviso: Es posible obtener el valor de la coordenada por defecto, dentro del sistema 
de coordenadas local, haciendo click en Default. No debería haber una gran 

diferencia entre el valor por defecto (default) y el valor conocido (known); en caso 
contrario, verifique los parámetros del sistema de coordenadas. 

 

 
3 Procesamiento de líneas base GNSS 

 
En este capítulo se explica el procesamiento de datos GNSS en modo estático y PPK, 

respectivamente, mediante la descripción de las configuraciones básicas del software. 

 
3.1 Procesamiento de líneas base estáticas 

 
En modo estático, Compass Solution puede procesar directamente vectores de líneas 

base de diferentes sitios con datos GNSS capturados simultáneamente. 

Recomendamos que al menos 3 receptores observen al mismo tiempo, para formar 

el bucle de líneas base simultáneamente. 

 

3.1.1 Visualización 

 

El vector de la línea base estático se formará automáticamente al importar los datos 

GNSS crudos. Seleccione Project -> Map para visualizar los vectores de líneas 

base. 
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3.1.2 Configuraciones del procesamiento de líneas base 

 

Antes de comenzar el procesamiento de líneas base estáticas, haga click en 

Processor -> Baseline setting en la barra de menú, para configurar los parámetros 

del procesamiento. Las configuraciones están relacionados con las reglas de 

importación de los datos (data import rules), observaciones, tropósfera y ionósfera. 

 

⚫ Sampling Interval (Intervalo de muestreo): Es el intervalo de procesamiento de 

los datos. Este valor debería ser mayor al intervalo utilizado durante la captura de 

los datos. 

⚫ Elevation Mask (Máscara de elevación): el ángulo mínimo de máscara a 

utilizar. Cuando los datos tienen buena calidad, la máscara debería ser de entre 

10 y 15 grados.  
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⚫ Min Time (Min.): Mínimo período de observación de los datos GNSS crudos, 

para formar la línea base.  

⚫ Max Distance (km): Distancia de observación máxima de los datos GNSS 

crudos para formar la línea de base.  
 

 

⚫ Seleccione los modelos de corrección por tropósfera y ionósfera. 

⚫ Parámetros del clima: temperatura, presión atmosférica y humedad relativa. 

⚫ Puede deshabilitar satélites individualmente para que los datos de estos satélites 

no formen parte de la solución. 

⚫ Compass time offset (offset de tiempo): el valor por defecto es de 14 segundos. 

 
3.1.3 Procesamiento de líneas base estáticas 

 

Después de definir los parámetros de procesamiento de las líneas base, haga click en 

Processor -> Process Static Baselines. 

 
Después de que se hayan procesado todas las líneas base, chequee el valor de 

calidad (Solution type, Ratio y RMS) y la información de las líneas base (dx,dy,dz,ds) 

que se muestran en el área de visualización. Para obtener un resultado de alta 

precisión, verifique también: 

⚫ Tipo de solución: Unsolved (No resuelto) o Fix (Fija). 
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⚫ Ratio debería ser menor que el valor de advertencia que haya establecido (por 
defecto el valor es 3) 

⚫ RMS < 0.00X (precisión milimétrica) 

⚫ Check: valid 

Además, puede hacer click en Adjustment -> Search Loop’s Errors para chequear el 

valor de PPM del bucle y obtener información detallada del procesamiento de las líneas 

base. 
 

Si los valores de RMS y Ratio de la línea base no cumplen con requisitos estándar, 

edite la línea base manualmente y procésela de nuevo. 

Elimine datos de observación de mala calidad en el Timeline window (Ventana de 

línea de tiempo) basándose en el Quality window (pestaña de calidad) Como se 

muestra en el ejemplo debajo, los datos de observación de mala calidad deben ser 

eliminados de la Timeline window. 

 
 

 

 
Aviso: en la Timeline Window, al seleccionar una observación, se eliminan los datos 

de dicha observación. Haga doble click en la casilla de la izquierda para limpiar la 

selección, y restaurar las observaciones eliminadas. 
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Procesar esta línea base nuevamente para obtener un mejor resultado. 

 
 
 
 

También es posible editar líneas base, incluyendo: 

⚫ Baseline setup (Configuración de línea base): Acceso directo a la configuración del 
procesamiento de líneas base. 

⚫ Baseline report (Reporte de línea base): Generar reporte del resultado del 
procesamiento de la línea base. 

⚫ Details of processing (Detalles del procesamiento): Muestra los detalles de los 
parámetros del procedimiento de cálculo. 

⚫ Baseline delete (Eliminar línea base): Eliminar la línea base de su proyecto (no es 

recomendable). 

⚫ Baseline forbidden (Línea base prohibida): No permitir que la línea base forme 

parte de la solución. Esta función es utilizada sólo cuando la línea base no posee 

buena precisión. 

⚫ Baseline using (Utilizar línea base): Permitir que la línea base forme parte del 
ajuste de red. 

⚫ Reverse start and end (Invertir Inicio y Final): Invertir la dirección del vector de línea 
base.  

⚫ Baseline properties (Propiedades de la línea base): Muestra información general, 
Fix Solution (Solución Fija) y Float Solution (Solución Flotante). 

  



Compass Solution - Guía del Usuario 
  

16  

 
3.1.4 Ajuste de Red 

 

En esta sección, se realizará un ajuste por mínimos cuadrados utilizando las líneas 

base procesadas anteriormente. En primer lugar, seleccione Adjustment -> 

Adjustment setup en la barra de menú. 

 

⚫ 3D: Coordenadas en WGS84 como puntos de control 

⚫ 2D: Ajuste horizontal, utilice coordenadas en cuadrícula local como puntos de 
control 

⚫ Height Fitting: Ajuste de altura 

Aviso: se recomienda aplicar 2D & Height para el ajuste de las líneas base. 

 

Luego, haga click en Adjustment->Run Adjustment, click en OK para completar el 
ajuste. 
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3.2 PPK (Cinemático con post-procesamiento) 
 

En el modo PPK (Post-Processed Kinematic), se pueden procesar trayectorias de 

Rover combinadas con datos estáticos de estaciones Base. Por lo general, se 

establece el intervalo de muestreo de la estación base en 1/s y se deja fijo sobre el 

punto conocido (vea 2.3 Puntos conocidos de anclaje). Se necesita el dongle (llave) 

para activar la función PPK. Asegúrese de que el dongle esté conectado a su PC y 

que el driver esté instalado correctamente. 

 
3.2.1 Procesamiento de línea base dinámica 

La configuración de los parámetros para línea base dinámica es la misma que la 

configuración del procesamiento de línea base estática (el intervalo de muestreo -

Sampling Interval-  es de 1/s). 

Haga click derecho sobre el nombre del archivo para procesar sólo esta línea base, 

como se muestra en la figura a continuación: 
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Haga click en Next para finalizar el procesamiento de la línea base dinámica. Se 

mostrará la información de la misma: Epoch Num (Número de época), Fixed Epoch 

(época fija) y Fixed percentage (Porcentaje fijo). 

 
Haga doble click derecho sobre la línea base dinámica para obtener información 

detallada de cada punto. 

3.2.2 Vista del mapa 
 

Al finalizar el procesamiento de la línea base dinámica, puede hacer click en Project -> 

Map para visualizar la trayectoria del Rover. 
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4 Exportar reporte 

 
Este capítulo brinda una introducción sobre cómo exportar reportes del procesamiento. 

 
4.1 Reporte estático 

 
Haga click en Report en la barra de menú principal para generar un reporte del ajuste de 

red en formato web. El mismo contiene 5 partes: Project property (Propiedad del 

proyecto), Coordinate system (Sistema de coordenadas), baseline (línea base), 3D non-

constraint adjustment (Ajuste 3D sin restricciones) y 3D constraint adjustment (Ajuste 

3D con restricciones), que le permitirá verificar el resultado de las líneas base y los 

ajustes.  

 

El parámetro más importante que debe chequear es X square check. Si el mismo 

muestra fail (falló), copie el valor del factor de referencia en Adjustment -> Adjustment 

Setup -> Free adjustment, y haga el ajuste de nuevo. 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

Aviso: el parámetro X square check es significativo y útil para el ajuste de redes 

triangulares. En el procesamiento de una sola línea base, sólo necesita verificar los 

parámetros Solution (Solución), Ratio (Relación) y RMS. 

 
Es posible exportar el reporte en otros formatos, incluyendo reportes resumidos, DXF 

y KML. Al finalizar, haga click en File -> Save para guardar su proyecto. 
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4.2 Reporte PPK 
 

Haga doble click sobre la línea base para obtener su información detallada. 
 
 

 
 

En la página de información detallada, haga click derecho para seleccionar Filter -> 

Export format, Solution Setup -> OK para elegir el formato del reporte. 

 
Formato de exportación: 

⚫ Latitud/Longitud: exportar el reporte en sistema de coordenadas WGS84. 

⚫ Projection (Proyección): exportar el reporte en el sistema de coordenadas de la 
cuadrícula local.  

⚫ Relative 2D: Distancia horizontal respecto de la estación base 

⚫ Relative distance: distancia 3D respecto de la estación base 

Solve style: Filtrar los resultados del procesamiento. Generalmente seleccione Fixed 

carrier phase (precisión centimétrica). 
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a) Output report, Output KML, Output PPK: recomendamos guardar el reporte en 

formato **.csv, lo que facilita el análisis del resultado del post-procesamiento, y en 

formato KML que genera archivos en formato compatible con Google Earth. 

 

b) Después de exportar el reporte, vaya a la barra de menú principal -> File -> Save, 

para guardar el proyecto. 

 


